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Introduction

In science, microscopy is one of the most exciting techniques. The in-
sight into small dimensions has led to a new understanding of, the struc-
ture of materials and forms of life.

With the help of the scanning tunneling microscope (STM) it is possi-
ble to look into the fascinating world of the atoms.

This manual gives  step by step operating instructions for the STM
‘easyScan’. It is kept short and simple and includes only the most
important explanations. The aim is to enable people who don’t have a
good knowledge of physics to easily get pictures of atomic resolution.

What is STM?
This completely new microscopy technique works without focusing ele-
ments and features atomic resolution (laterally and vertically). A small
sharp platinum tip is scanned across the sample’s surface, so close that
the so-called ‘tunneling current’ can flow. With the help of that current
the tip-surface distance can be controlled very precisely. Therefore an
enormous resolution is achieved so that the atomic arrangement of me-
tallic surfaces can be ‘probed’.

INTRODUCTION
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It is incredible to be able to get such excellent pictures of atomic resolu-
tion considering that the size of the atom, in relation to the scanning
tip, is that of a ping-pong ball to a mountain!

The Scanning Tunneling Microscope was developed by Gerd Binnig and
Heinrich Rohrer in the early 80’s at the IBM research laboratory in
Rüschlikon, Switzerland. For this revolutionary innovation Binnig and
Rohrer were awarded the Nobel prize in Physics in 1986.

Scanning with ‘easyScan’
With the easyScan STM the platinum tip is clamped between two tiny
springs and a platform which can be moved in all three dimensions.

All three axes are driven very precisely in the nanometer range, by piezo-
crystal translators.

INTRODUCTION
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The sample which is to be examined is brought close to the tip (or
approached) to a distance of about 1 nanometer (10-9m = 1nm). Classi-
cal physics would prohibit the appearance of electrons in the small gap
between a tip and a sample.

But if a sharp tip and a surface are  put under a low voltage (U~0.1V) a
very small current (I~1nA) may flow between tip and sample: the
tunneling current is a quantum physics effect and the tunneling current
depends exponentially on the distance between the tip and the sample.

Since this tunneling current is extremely dependent on the distance be-
tween tip and sample, the tip movement can accurately be controlled.

The tip is scanned over the sample. By keeping the current between tip
and sample constant by a feedback loop (constant current mode) the
distance between tip and surface is also kept constant and the tip follows
the structure of the sample’s surface.

x

z

I = const.

The tip is probing the surface in a constant distance

(viewed from top)

The movements of the tip are recorded during scanning and the “land-
scape” of the atomic surface can be simultaneously drawn on the com-
puter screen line by line.

INTRODUCTION
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Scan-images of graphite as views from the ‘side’ and the ‘top’

The sample can also be scanned in a second mode: Turning the feedback
loop off or very slow (P-Gain=0, I-Gain=2) the tip scans at a fixed dis-
tance from the sample (constant height mode). This time the variations
in the tunneling current are measued and drawn line by line on the
computer screen.

What is so special about the ‘easyScan’?
With easyScan it is possible to do any STM experiment which can be
carried out in air. All functions can be carried out by the computer.

The instrument is designed to be compact, simple and comfortable to
operate.

INTRODUCTION
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Preparation

In the following sections installation of the ‘easyScan’ STM is described.

Important!
To enable measurements of atomic resolution to be made the following
precautions must be taken to keep equipment dust and grease free:

- Never touch either the wire for tips (7), the sample (8) nor the open part
of the scan head (4) with your fingers.

- Only touch the sample holder at the black plastic end.

Please also pay attention to the chapter ‘maintenance’.

Components
After unpacking the instrument suitcase check for the following items:

PREPARATION
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 1 - Serial cable between computer and control electronics

 2 - Power pack

 3 - Transparent cover

 4 - Scan head

 5 - Control electronics

 6 - Magnifying glass

 7 - 30 cm Pt/Ir - wire for tips

 8 - Samples HOPG (graphite) and gold thin film

 9 - Software installation disc

10- Sample holder

11- Tweezers

12- Cable

13- Vibration isolation platform

Plus-  A test sheet and a sheet with the calibration information.

Required additional material

• Computer with a free COM-Port and Windows 3.1/95

• Wire cutters and flat-nosed pliers (available in the tool set)

• Solvent to clean the tools (e.g. ethanol, aceton)

PREPARATION
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Assembly

Caution:

- Please check that the mains voltage corresponds to that of the power
supply (2).

- Make sure that your mains connection is protected against excess volt-
age.

Choose a steady table where you can work undisturbed. To ensure the
faultless operation of the STM it has to be kept away from vibrations,
heat emission and air current.

- Put the scan head (4) onto the vibration damping stage (13). Fix the
scan head cable under the strain relief clip.

- Connect the scan head (4) to the control electronics (5).

PREPARATION
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- Make sure your computer is turned off. Then connect the control
electronics to a free serial port (COM-Port) on your computer with
the serial cable (1).

- Connect the power supply (2) to the control electronics.

- Finally plug in the power supply with the aid of the main cable (12).

Now the scan electonics (LED flashes red) and the microscope are con-
nected.

Software installation (Windows)

System requirements for ‘easyScan’ are:

• PC with 486DX / 50 MHz processor or higher (Pentium / 133 Mhz
recommended)

• 8Mb RAM or more (16 Mb recommended)

• graphics adapter with 800 x 600 resolution and 256 colours or better
(resolution of 1024 x 768 recommended)

- Turn on your computer and start Windows.

- Insert the backup copy of your installation disk (9) into the disk drive.

- Start the installation program ‘setup.exe’ from the floppy disk (9):

Win 95:

- Activate the file ‘setup.exe’ on the disk; or choose from the ‘START’-
Menue ‘Run...’ and type the disc drive name followed by a colon and
the setup command e.g. ‘a:setup.exe’ and then press ‘OK’.

Win 3.1 or Win 3.11:

- Choose from the Program Manager ‘File->Run...’

- Type in the command line box ‘a:setup.exe’, and then press ‘OK’.

PREPARATION
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For all systems:

- Select the button ‘Install’, to install the data acquisition program
‘easyScan’ on your computer.

Setup will ask for the directory in which the program files are to be
copied:

- We recommend  putting them under the name ‘easyScan’ by pressing
‘OK’.

Afterwards setup will ask for the program group in which ‘easyScan’ is to be
placed:

PREPARATION
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- Accept the program’s proposition by pressing ‘OK’ or type in another
name.

The installation setup will now ask for the ’COM-Port’:

- Select the serial port to which  you have connected the control electronics
(5). (see chapter ‘assembly’)

Finally you have to indicate the settings of your screen area:

- Choose the corresponding data and press ‘OK’.

After successful installation you will get this confirmation and find the data
acquisition program ‘easyscan.exe’ in the directory ‘easyScan’.

PREPARATION
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Controlling the calibration of the scanner

- Please follow the instructions on the ‘calibration information’ sheet
which you received with your easyScan STM system.

‘Simulate microscope’
You can start the ‘easyScan’ program without having the microscope  con-
nected. In this case a dialogue box says:

By pressing ‘Cancel’ a simulation of the microscope is started. This imitates
most of the functions of the real microscope. The sample is replaced by a
mathematical description of an atomic arrangement.

Our tip:

We recommend using this simulation, as the easyScan-system
(measurements and software) can be encountered ‘offline’!

- Make sure that ‘Simulate Microscope’ in the menu ‘Options’ is activated
and then follow the instructions in the ‘Start measurement’ chapter .

PREPARATION
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Preparing and installing the scanning tip
The scanning tip is prepared and installed by you. This is the most difficult
part of your preparations. It usually needs patience and some practise to get
the first good tip (Especially because only an accurately cut tip enables opti-
mal measurements.). Cutting and installing should be carried out with great
care as a good result relies heavily on the accuracy of this process.

1. First ensure that the cutting part of the wire cutters, the flat-nosed
pliers and the tweezers (10) have been cleaned with ethanol. Touch
the platin wire (7) with these tools only.

2. hold the end of the wire firmly with the pliers and cut a piece off
approximately 5mm long.

3. Still holding this piece of wire with the pliers, place the cutters at the
free end, as obiquely as possible. (see picture below)

4. Close the cutters until you can feel the wire, then in the direction
shown below, pull and cut at the same time. The tip needs to be torn
off rather than cleanly cut off in order to get the required point.

PREPARATION
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Important:

• Never touch the tip end with anything!

• The golden tip holders in the open part of the scan head are very
delicate and not to be twisted!

5. Hold the wire with the tweezers behind the freshly cut tip.

6. Insert it carefully under the golden tip holders in the scan head with-
out twisting them (see below).

Tip:  First put the end of the wire under the arched part of the tip
holders and slide it sidewards into the notch: see a) and b):

     

mounting the scanning tip

PREPARATION
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The freshly cut tip should be well held under the clamps and reach
about 2-3mm beyond the tip holder.

The scanning tip is now installed.

Preparing the sample
The STM can only examine electrically conductive materials. Neverthe-
less the choice of material is rather small because the surface of the sam-
ple must be totally clean and mirror-like to obtain useful results. Because
of that some of the samples need special preparation.

Gold thin film
Cleaning the sample is neither possible nor necessary. Never touch the
sample with your fingers or put it upside down anywhere, this will only
make it unusable faster.

Graphite
The surface of the graphite sample should be cleaned every few months.
Due to the layered structure of graphite this can easily be done by using a
piece of adhesive tape: (see pictures below)

- Put the sample on the table using the pair of tweezers.

- Stick a piece of adhesive tape gently to the graphite and then pull it off
again: The topmost layer of the sample should stick to the tape.

- Remove any loose flakes with the pair of tweezers.

      

PREPARATION
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The graphite sample is now ready for use and may not be touched with
the fingers.

Installing the sample

- Unpack the sample holder (10) touching only its black plastic end.

- Put the prepared sample onto the magnetic end of the sample holder
using a pair of tweezers. (See  below)

           

- Place the sample holder carefully in the scan head so that it doesn’t
touch the scanning tip (see above).

Caution!
Avoid strong mechanical impact on the piezo motor while placing the
sample holder in the scan head.

- Put the sample holder down on to the guide bars first and release it
gently on to the piezomotor’s support.

PREPARATION
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Measuring Graphite

All the preparations are now done:

The STM is assembled, the software, a scanning tip are installed and a
sample is ready.

In this chapter step by step instructions are given on how to operate the
microscope and get your first pictures. More detailed explanations of the
software and the system are given in the software manual.

Important!

- Never touch the sample surface of the scanning tip! Good results rely
heavily on the accuracy of the preparation of the tip and the sample.

- The tip must never come in direct contact with the sample. This damages
the fine tip and it has to be cut again.

Starting the microscope

- Check if the power pack (2)  is connected to the AC mains power supply:

The red LED of the control electronics (5) flashes or shines.

- Run the data acquisition program ‘easyScan’ on your computer:

The main program window and the ‘Scan Panel’ appear.

MEASURING GRAPHITE
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When the red LED of the scan electronics has been flashing then a dialogue
box will appear saying ‘Downloading code to microscope...’:

This means your computer is communicating with the control electronics
and exchanging important data. This process is performed every time the
control electronics have been turned off. After download is completed the
red LED changes from flashing to constant and the LED on the scan head
(4) shines orange.

Now the system is ready to use.

MEASURING GRAPHITE
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Approaching the tip
To start measuring, the sample must be very close to the tip to enable a
tunneling current to flow. Approaching the sample without touching
the tip, is a delicate operation carried out in three steps. The LED on the
scan head tells you about the distance between the tip and the sample:

LED orange: Distance is too big, no tunneling current is flowing.

LED red: Sample touched or ‘crashed into’ the tip, tunneling
current is too high.

LED green: Sample is in the measuring area, tunneling current is
flowing.

1. Coarse approach by hand

- Push the sample holder (10) carefully to within 1mm distance of the
tip.

- If necessary try turning the sample holder a little so that the tip points
towards a mirror-like area of the sample.

- Put the transparent cover (3) over the scan head without touching the
sample holder.

The cover reduces air flow around the scanner to avoid severe thermal
drift in measurements at atomical scale.

MEASURING GRAPHITE
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2. Fine approach by piezo motor

- Choose the menu ‘Panels’ of the ‘easyScan’ program.

- Open the ‘Approach Panel’.

- Watch the distance between tip and sample with help of the magnify-
ing glass. Now press  in the ‘Approach Panel’ to move the sam-
ple towards the tip to a distance of a fraction of a millimetre.

Tip:  Watch the tip and its mirror image on the sample surface with the
magnifier.

- Open the ‘Feedback Panel’ in the menu ‘Panels’.

- Ensure that the following parameters are set correctly:

• the ‘SetPoint’ (tunneling current) on approx. 1.00nA,

• the ‘GapVoltage’ (tip-sample-voltage) on 0.05V,

• the ‘P-Gain’ on 12 and the ‘I-Gain’ on 13 (feedback loop param-
eters).

MEASURING GRAPHITE
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3.Automatic approach

- Press  in the ‘Approach Panel’:

With the help of the piezo motor the sample holder is moved towards
the scanning tip until the tunneling current defined by ‘SetPoint’ is
detected. Now the distance between sample and tip is controlled auto-
matically by the electronics. If the approach was successfully done the
LED on the scan head changes from orange to green and the dialogue
box ‘Approach done’ appears.

- Press ‘OK’.

Now the tunneling current which has been set, is flowing between scan-
ning tip and sample.

The sample may „crash“ into the tip:

Then the LED changes to red and the scanning tip has to be cut again:
(see chapter ‘F&F’).

Start measurement
When the tunneling current defined by ‘SetPoint’ flows between tip
and sample (LED green) you can start measuring:

- Press  in the ‘Scan Panel’ to maximize the range of the scan.

- Start measuring by pressing  in the ‘Scan Panel’.

MEASURING GRAPHITE
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If the preparation of tip and sample and the approach were successful
images of the measurement will be drawn showing a line in the ‘LineView’
and a plane in the ‘TopView’. Watch the displays for a while until the
‘TopView’-image has been drawn about three times.

   

A ‘nervous’ and a good starting-picture

A ‘nervous’ line in the ‘LineView’ indicates a bad tunneling contact.
Usually this is caused by the tip being too blunt or instable. This means
that you should stop measuring and cut a new tip:

- Press  and follow the instructions of the chapter ‘F&F’.

If the line in the ‘LineView’ is calm and reproduces consistently you can
follow the next chapter.

Adjusting the sample’s tilt coordinates
In the ‘LineView’ window a cross section of the sample’s surface is pre-
sented at the actual scan position (= scan line); see schematic view A and
B on the next page.

The ideal scan range for the tip lies in the x,y-plane of the piezo-scanner.
But mostly the sample is tilted with respect to that ideal plane. Since
the sample’s tilt cannot be compensated for directly, the scan coordi-
nates have to be adjusted accordingly. By setting suitable values for X-
and Y-slope the scanner’s coordinate system is ‘tilted’ so that the sam-
ple’s surface appears to lie in the ideal x,y-plane.

MEASURING GRAPHITE
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Sample’s orientation before tilt adjustment

You can alter the various parameters in the ‘Scan Panel’ by using the
arrow buttons  step-by-step or overwrite the old values by typing in
the new ones. In the latter case you must confirm your entry by klicking
button  or hitting the ‘Enter’-key:

1. Alter the value of ‘X-Slope’ using the arrow buttons until the scan line
lies parallel to the x-axis.

2. Enter the value 90 for ‘Rotation’ to display the scan line in y-direction
i.e. the sample’s tilt as shown in the schematics view B.

3. If the scan line is not horizontal alter the value for ‘Y-slope’ until the
scan line lies parallel to the y-axis.

4. Reset the ‘Rotation’ to 0°. The ‘LineView’ shows the view in A again.

Now the ideal scan range is set to the sample’s tilt.

The value of the ‘Z-Offset’ varys slightly during measurement. This is
correct because in the menu ‘Options’ the option ‘Auto. Adjust Z-Off-
set’ should be active.

MEASURING GRAPHITE
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Displays after adjusting the slopes

Achieving atomic resolution
You prepared your measurement so that the scan line in the centre of the
‘LineView’ is reproducing stabily. Now the scan range has to be reduced and
the measured signals amplified in order to observe the atomic structure.

Reminder: Measurements on the nanometer scale are very sensitive. Direct
light, fast movements causing air flow and temperature variations near the
scan head can influence and disturb the measurement. It is best to let a
promising measurement run for some time to let it stabilize thermally.

The following statements apply to graphite:

1. Reduce the value of ‘Z-Range’ in ‘ScanPanel’ to 50nm in order to
concentrate the mesurement to this range.

MEASURING GRAPHITE
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Diminishing ‘Z-Range’ amplifies the signal in Z-direction

2. Limit the scan range as follows:

- klick on the ‘TopView’-Display to make sure that it is active: its titlebar
is the same colour as the main bar.

- klick on : The mouse pointer becomes a cross and the ‘Tool Info
Panel’ opens.

- look for a ‘flat’ region (similar grey values) in ‘TopView’ and with the
mouse pointer make a square there. The size of the square is shown in the
‘Tool Info Panel’.

 

MEASURING GRAPHITE
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- Release the mouse button when the square’s size is about 30-50nm.

- By double clicking on the display using the left mouse button you
confirm the selection and consequently the selection is enlarged to the
whole display size. You can abort the zoom function by klicking with
the right mouse button.

3. Atomic arrangements can normally be made out at a ‘ScanRange’ of
about 4 nm and at a ‘Z-Range’ of about 1.5 nm.

- Set these values in ‘Scan Panel’ one after the other. Have a play with
these values, they can be reduced even further. Between changes al-
ways allow the computer to scan the picture a couple of times before
continuing.

- Pay attention to the height of the signal in the ‘LineView’ window. It
should not exceed the window height, if so the z-Range is set too small
and should be increased.

To help you understand the ‘Dimensions’: One nanometer is between
four and eight atoms.

4. Some parts of the scan head react to the slightest temperature changes.
As these thermal ‘movements’ influence the measurements on the
nanometer scale, the sample has to be scanned as fast as possible.

- Set the ‘Time/Line’ in the ‘ScanPanel’ to 0.06s for atomic resolution.

5. In the ‘TopView’ window the values which do not fit in the selected
colour range appear coloured: red points are too ‘high’ and blue
points are too ‘low’.

 

MEASURING GRAPHITE
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- If a lot of blue and red points appear, open the ‘View Panel’ and select
 in the ‘Visible Input Range’ section

good images of a successful measurement

 Snapshots of  images
If you are happy with your image and would like to keep it, you can take
a snapshot and save it later:

- When you see that a good image is being produced line by line then
during the measurement you can select  in the ‘ScanPanel’. After
having completed the actual frame, a copy of the measured image is taken
and displayed in a separate window behind the ‘ScanPanel’.

- If you would like to take the snapshot of the view as it appears during
the measurement without waiting to finish the frame, you have to stop
the scanning by using  and generate a copy of the view using

.

- After having finished the measurements you can store the ‘photographs’
of your measurements in a storage medium e.g.  your PC’s hard drive
(see Chapter ‘Finish measuring and save images’)

MEASURING GRAPHITE



 28

Judging the quality of the images
From the quality of the measured images the quality of the scanning tip
and consequently that of the tunneling contact can be observed. A good
tunneling contact is necessary for high quality images of atomic resolu-
tion.

• If temperature variations are present they cause so called ‘thermal
drift’. Consequently the images are stretched. This effect can be ob-
served when e.g. the upward scan is much different from the down-
ward scan showing two differently distorted lattices.

   

consequent upward and downward scan showing thermal drift

Thermal drifts are very clearly perceptible on an atomic scale. Already
variations of  1/10°C cause variations in the length of e.g. the sample
holder (steel) of several nanometers!

In this case it is important to keep the measurement running for some
time to let the system stabilize (up to about one hour).

• If during a good measurement the image quality diminished dramati-
cally the tip has most probably picked up some particles.

MEASURING GRAPHITE
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- See chapter ‘F&F: Image quality suddenly deteriorates’

In the following cases the scanning tip has to be replaced i.e. cut freshly
in order to establish a stable tunneling contact and high image quality:

• If images in top view consist of only of uncorrelated lines:

• If the images are ‘smeared out’ on one border (here on the left border):

• If each image looks different:

MEASURING GRAPHITE
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• If the scan lines in ‘LineView’ are unstable and the image in the
‘TopView’ is not ‘sharp’:

MEASURING GRAPHITE
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Turning off and putting away the ‘easyScan’

Finish measuring and save images

- To stop a measurement click onto the button .

- By hitting  then pressing  in ‘Approach Panel’ you
can retract the sample holder to a safe and visable distance from the
tip.

- Close all panels inorder to see the saved ‘snapshots’.

- Activate the ‘snapshot’ that you would like to save, by clicking onto
the image. Select the menu ‘File->Save as...’. Select the name and the
folder where you would like to store the images (filename with a
maximum of 8 characters).

These stored images and all the corresponding data can be opened with
the ‘easyScan’ software , viewed, analyzed and printed (ref. also ‘Software
Reference’ manual) anytime.

Turning off and storing the instrument

- Finish the program ‘easyScan’ after having stored all desired images. If you
leave the program without saving some data the program asks if you
really do not want to save them (saftey):

If however you would like to save some images use . If not you
can leave the program with .

- Disconnect the power pack from the power supply.

TURNING OFF AND PUTTING AWAY THE

‘EASYSCAN’
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If you perform measurements regularly leave the instrument with the
cover over the scanner to protect it against dust.

If you do not operate the instrument for several weeks you should put it
back into the instrument suitcase:

- remove sample and sample holder and pack up all parts. The scanning
tip can be left in the scanner.

By storing the instrument in the suitcase it is protected from dust. Si-
multaneously the rubber feet of the vibration isolation platform should
be relieved. The damping capability may decrease with time.

TURNING OFF AND PUTTING AWAY THE

‘EASYSCAN’
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Notes about the graphite surface

In a good top view image of graphite you will see a pattern consisting of
white, grey and black spots. It looks like a three dimensional image of
balls lying next to each other, but be careful: these are not the single
atoms!

To interpret the image correctly you must first be aware that bright
spots show high points and dark spots low ones (except in ‘LineMath’
‘Derive’).

0.25nm
0.14nm

0.34nm

Out of the lattice model of graphite one can see that there are two different
positions of the carbon atoms in the graphite crystal lattice: One with a
neighbouring atom in the plane below (grey) and one without a neighbour
in the lattice below (white).

Consequently the electrical conductivity of the graphite surface varies lo-
cally slightly so that the atoms without neighbours appear higher than the
others.

This also causes the latttice constant between the bright ‘hills’ to have the
higher than normal value of 0.25nm.

NOTES ABOUT THE GRAPHITE SURFACE
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Measuring Gold

It is more difficult to obtain good images of a gold.

Atomic structures are difficult to observe because the electrons on the
surface are much more homogeniously distributed unlike graphite. But
with some training the mono atomic gold steps can be observed.

Due to the fact that the gold sample cannot be cleaned by simple means
it is possible that with time contaminants may prevent you obtaining
good results.

Tip:

Before you do any experiments with the gold sample it is necessary to
practise on the graphite sample. You should also test the quality of your
tip using the graphite sample.

- Proceed as you did with the graphite sample (preparation & slope
compensation), but there are two exceptions to note:

MEASURING GOLD
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- select a gap voltage between 0.3-0.5V.

- increase the value of parameter ‘Time/Line’ to 0.3s in the ‘Scan
Panel’.

If you do not get stabily reproduced scan lines you should look for another
clean measuring spot.

- First try with  followed by .  If that does not
change much retract the sample holder and rotate it alittle by hand.
Repeat the approach.

- If the image reproduces stabily decrease the ‘Z-Range’ to 50nm and
select a ‘ScanRange’ between 200 and 300nm.

- Now decrease the ‘Z-Range’ to 12nm or less.

Of course you can evaluate your measurements in the same way as you
did with the graphite images, zoom, measure, save etc.

MEASURING GOLD
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Maintenance

To ensure a faulty free operation of the microscope the following instruc-
tions for maintenance have to be followed.

Scan head
It is very important to keep the sample holder and the open part of the
scanner clean. If exposed to moisture (high humidity), corrosion will
appear.

- If anyone touches the metal part of the sample holder or it does not
move freely, clean it with a soft cloth moistened with alcohol.

- Clean the sample holder guide bars (see picture above), the surfaces of
the piezo motor and the tip holder with a cotton swab lightly mois-
tened with alcohol, ensure the tip is removed when doing this!

Scan electronics
Clean the cabinet and the controls with a soft cloth lightly moistened with
a mild detergent solution. Do not use any abrasive pad or solvent like alco-
hol or benzine.

MAINTENANCE
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F&F: Frustrations & Failure

‘Approach’ is too slow / stops sometimes

- Clean the sample holder guide bars, the surfaces of the piezo motor with
a cotton swab lightly moistened with alcohol. Let the parts dry suffi-
ciently.

- If cleaning was no improvement open the ‘Approach Panel’s extended
configuration using its  button.

- Increase the value of ‘Stepsize’ and press .

Now the motor moves the sample holder with larger steps during automatic
approach.

- Save the new value for ‘Stepsize’ using menue ‘File->Parameters->Save’

Tip often crashes into sample during ‘Approach’
In this case the motor moves the sample holder with too bigger steps
towards the scanning tip:

- Open the ‘Approach Panel’s extended configuration using its  button.

- Decrease the value ‘Stepsize’ in  ‘Automatic Move Configuration’ by about
10% and press .

- Repeat the approach with a new tip. If the approach fails again, reduce
‘Stepsize’ further.

- Save the best ‘Stepsize’ value using menu ‘File->Parameters->Save’

Image quality suddenly deteriorates

• When a scan line suddenly starts reproducing badly, the tip may have
picked up some particles:

- Continue measuring for a while (4-5 images) eventually the tip
looses the picked up material again.

F&F: FRUSTRATIONS & FAILURE
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- You can try to induce changements at the tip’s end: While measur-
ing increase the gap voltage in the ‘Feedback Panel’ to 2V then
reduce it to the old value again.

- You can also induce changes of the tip’s end by increasing the
tunneling current to 20nA for a short time then reducing it to its
old value again.

- Retract the sample using  then perform a new approach.

   If after these procedures no improvement can be seen, you have to
prepare a new tip.

• Did the scan line in the ‘LineView’ suddenly disappear and the LED on
the scanner turns orange the tip has lost contact:

- Use  in the ‘Approach Panel’ then repeat the steps in
chapter ‘Start measurement’.

• If the LED flashes green-orange while measuring then the tip is loosing
contact from time to time and the tunneling contact is very unstable.

- In the ‘Approach Panel’ select  then  and
repeat the steps in chapter ‘Start measurement’.

Cutting a new scanning tip
After a crash (the scanning tip with the sample) or when scan lines start
reproducing badly and consequently the image deteriorates you should
proceed as follows:

- Remove the transparent cover from the scan head.

- Retract the sample holder first by using  then .
Remove the sample holder by hand.

- Pull the tip out from under the tip holders carefully, using a pair of
sharp tweezers.

- Carefully follow the instructions in chapter ‘Preparing and installing
the scanning tip’.

- Repeat procedures in chapter ‘Measuring graphite’.

F&F: FRUSTRATIONS & FAILURE
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Sample holder moves too slowly / stops sometimes
If the fine approach using  and  is affected:

- Clean the sample holder, guide bars and the surfaces of the piezo motor
with a cotton swab lightly moistened with alcohol.

‘No connection to microscope!’

This error message appears when the scanning software is waiting for an
answer from scan electronics. This can have various reasons:

• The microscope is not connected:

- If you wish to perform a simulated measurement select . oth-

erwise check the connection and select .

• The scan electronics is not connected to the power supply:

- check the connection.

• The scan electronics is not connected to the computer with a serial cable:

- check the connection.

• The scan electronics performs a task which lasts an unforseen length of
time causing a timeout. Using Windows NT this can happen when
the system is occupied with itself and blocks the serial port:

- Use .

• During software installation the wrong COM-port has been selected:

- Use  and exit the program ‘easyscan’.

- Check which port the scan electronics is connected to.

- Open folder 'easyScan' and edit using a text editor the file ‘Easyscan.ini’

F&F: FRUSTRATIONS & FAILURE
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- Set the correct port number in section ‘[WinSer]’ under item
‘ComPort= ’.
Caution: Do not alter any other values in this file!

- Save the file ‘Easyscan.ini’ and restart the ‘easyscan’-program.

• The electronics is broken.

- Contact your dealer.

Z-Offset does not change automatically
In the default configuration of the easyscan software the item in menu
‘Options->Auto. Adjust Z-Offset’ is activated. If the numeric value of ‘Z-
Offset’ in the ‘Scan Panel’ does not alter slightly during scan:

- Check whether the option is activated.

- Eventually the tip is at one of the limits of the z-piezo. Use
 then .

- The scan line is at the one of the limits of the z-range. Increase the
value of ‘Z-Range’.

F&F: FRUSTRATIONS & FAILURE
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Technical Data

• scan range max.: 0.5µm × 0.5µm in x - and y - directions.

• scan range max.: 200nm in z - direction.

(the exact values are dependent on the calibration of the piezo elements.)

• scan speed: 60ms per 128 datapoints

• minimal step size: 0.015nm

• gap voltage: ±10V in 5mV steps

• set point current: ±100nA in 25pA steps

• feedback loop bandwidth: 3 kHz

• baud rate controller-host: 38400 bps

TECHNICAL DATA



 42

ea
sy

S
ca

n 
v1

.3
 

F
un

kt
io

ns
pr

in
zi

p 
S

T
M

(c
) 

by
 N

an
os

ur
f A

G
, L

ie
st

al

13
.1

1.
97

D
.M

ül
le

r

1/
1

X-Axis   16Bit

Y-Axis   16Bit

Z-Axis   16Bit

GapVolt. 12Bit

I/U
 C

on
ve

rt
er

ZStepper 12Bit

+

-

1.
.2

56

-

+

SetPoint 16Bit

ADC0  12Bit

ADC1  12Bit

C
P

U
C

us
to

m

pr
og

.

Lo
gi

c

R
S

23
2

H
os

t P
C

R
A

M

R
O

M

S
T

M
 H

ea
d

O
pt

io
na

l
S

ca
nn

er
T

ip

S
am

pl
e

Z
 A

pp
ro

ac
h

10
0m

V
/n

A

+-10V

+-12V

+-12V

+-12V

+-13V

-+13V

+-10V

+-10V

+-10V

D
ig

ita
l I

/O

2
3

O
ut

 (
5V

)
In

 (
5V

)

G
N

D

P
ow

er

+
15

V

-1
5V

+
5V

22
0V

/1
10

V
A

C



43

Index

A
additional material  7
Approach Panel  20
Approachi  19
Assembly  8
atom  3
Atomic arrangements  26
atomic resolution  2
Auto. Adjust Z-Offset  23
Automatic approach  21

B
blue points  26

C
calibration  12
cleaning  37
Coarse approach  19
COM-Port  11
Components  6
constant current mode  4
constant height mode  5
cover  19
Cutting a new tip  38

D
Downloading code...  18

E
easyScan  5
Extent of delivery  6

F
Failure  37

Fine approach  20

G
GapVoltage  20
Gold  15
graphics adapter  9
Graphite  15
graphite surface  33

I
I-Gain  20
installation  6
Installing the sample  16

L
LED  19
LED green  19
LED orange  19
LED red  19
LineView  22

M
mains connection  8
Maintenance  36
Measuring Gold  34
Measuring Graphite  17
mono atomic gold steps  34
mounting the scanning tip  14

N
‘No connection to microscope!’  39

O
Optimize  27

INDEX



 44

P
P-Gain  20
Photo  27
piezo  3
piezo motor  21
platinum tip  3
precautions  6
Preparing the sample  15

R
red LED  18
red points  26
Rotation  23
rubber feet  32

S
sample’s tilt  22
Save as...  31
scanning  4
scanning tip  3, 13, 38
Scanning Tunneling Microscope  3
serial cable  9
SetPoint  20
Setup  10
Simulate microscope  12
snapshot  27
Software installation  9
Start  21
System requirements  9

T
thermal drift  28
tilt  22
Time/Line  26
Tip crashes  37
TopView  22
Transparent cover  7
tunneling current  4
Turning off  31

U
unpacking  6

V
vibration damping  8
Visible Input Range  27

W
What is STM?  2
Withdraw  31

X
X-Slope  23

Y
Y-slope  23

Z
Z-Offset  23

INDEX

TEXT & LAYOUT: KARIN HOOL & ROBERT SUM

ENGLISH VERSION: VICKI CONNOLLY



Nanosurf AG
Austrasse 4
CH-4410 Liestal

E-Mail
info@nanosurf.com

World Wide Web   Nanosurf AG, 1998
Printed in Switzerland www.nanosurf.com

www.nanosurf.com

	Table of Contents
	Introduction 
	What is STM? 
	Scanning with 'easyScan' 
	Preparation 
	Assembly 
	Software installation (Windows) 
	Preparing and installing the scanning tip 
	Preparing the sample 
	Installing the sample 
	Measuring Graphite 
	Starting the microscope 
	Approaching the tip 
	Start measurement   
	Adjusting the sample's tilt coordinates    
	Achieving atomic resolution  
	 Snapshots of  images 
	Judging the quality of the images 
	Turning off and putting away the 'easyScan' 
	Finish measuring and save images  
	Turning off and storing the instrument 
	Notes about the graphite surface 
	Measuring Gold 
	Maintenance 
	Scan head 
	Scan electronics 
	F&F: Frustrations & Failure 
	Technical Data 
	Index 

	Index
	A
	additional material  
	Approach Panel  
	Approachi  
	Assembly  
	atom  
	Atomic arrangements  
	atomic resolution  
	Auto. Adjust Z-Offset  
	Automatic approach  

	B
	blue points  

	C
	calibration  
	cleaning  
	Coarse approach  
	COM-Port  
	Components  
	constant current mode  
	constant height mode  
	cover  
	Cutting a new tip  

	D
	Downloading code...  

	E
	easyScan  
	Extent of delivery  

	F
	Failure  
	Fine approach  

	G
	GapVoltage  
	Gold  
	graphics adapter  
	Graphite  
	graphite surface  

	I
	I-Gain  
	installation  
	Installing the sample  

	L
	LED  
	LED green  
	LED orange  
	LED red  
	LineView  

	M
	mains connection  
	Maintenance  
	Measuring Gold  
	Measuring Graphite  
	mono atomic gold steps  
	mounting the scanning tip  

	N
	'No connection to microscope!'  

	O
	Optimize  

	P
	P-Gain  
	Photo  
	piezo  
	piezo motor  
	platinum tip  
	precautions  
	Preparing the sample  

	R
	red LED  
	red points  
	Rotation  
	rubber feet  

	S
	sample's tilt  
	Save as...  
	scanning  
	scanning tip  
	Scanning Tunneling Microscope  
	serial cable  
	SetPoint  
	Setup  
	Simulate microscope  
	snapshot  
	Software installation  
	Start  
	System requirements  

	T
	thermal drift  
	tilt  
	Time/Line  
	Tip crashes  
	TopView  
	Transparent cover  
	tunneling current  
	Turning off  

	U
	unpacking  

	V
	vibration damping  
	Visible Input Range  

	W
	What is STM?  
	Withdraw  

	X
	X-Slope  

	Y
	Y-slope  

	Z
	Z-Offset  



